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Preface
In the demanding global marketplace, ensuring that human fit, form, and 
function are comprehensively addressed is becoming an increasingly important 
aspect of design. Human Activity Analysis is based on a best-in-class human 
modeling system, which for many years has permitted detailed investigation 
into human-centered design issues in the context of a workplace before it 
physically exists. Human Activities Analysis specifically focuses on how a 
human will interact with objects in a working environment, as well as the 
effects of lifting, lowering, pushing, pulling and carrying on task performance.

Human Activity Analysis evaluates all elements of human performance from 
static posture analysis to complex task activities. Human Activity Analysis 
possesses a range of tools and methods that specifically analyze how a 
manikin will interact with objects in the virtual environment. The NIOSH 
1981/1991 and Snook and Ciriello equations measure the effects of 
lifting/lowering, pushing/pulling, and carrying to fully optimize task 
performance. A designer can determine a number of task variables such as 
action limit, recommended weight limit, and maximum lifting/lowering weight. 
Benefits include accurately predicting human performance, ensuring 
conformance to health and safety standards and maximizing human comfort 
and safety.

Human Activity Analysis is part of the V5-based human modeling solution that 
also includes Human Builder, Human Posture Analysis, and Human 
Measurement Editor. Together, these tools provide designers with a 
comprehensive, quantitative and intuitive capability to design products that 
reflect the key skills as well as the limitations of the target audience.
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Using this Guide
This book describes how to use Human Activity Analysis. Before you read it, 
you should be familiar with basic concepts such as document windows, 
standard tool bars, and view tool bars. 

If you are new user, start with the tutorial in the Getting Started section. 

The User Tasks section of the book provides procedures for using the features 
of Human Activity Analysis.

A Workbench Description section describes each functional icon or command 
in the workbenches. 

The Glossary provides definitions of terms specific to Human Activity Analysis 
and related products. 
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Where to Find More Information
Prior to reading this book, we recommend that you read Human Builder.  We 
also recommend that you read: 
●     Human Measurements Editor

●     Human Posture Analysis

●     Conventions
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize 
and understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:
●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:
This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task

functionalities that are new or enhanced with this Release.

allows you to switch back the full-window viewing mode.

Graphic Conventions Indicating the Configuration Required 
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Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary

Index

Text Conventions

The following text conventions are used:

  The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the 
text.
  File -> New identifies the commands to be used.
  Enhancements are identified by a blue-colored background on the text. 

How to Use the Mouse
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The use of the mouse differs according to the type of action you need to perform.
Use this

mouse button...
Whenever you read...

 

●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the 
document window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)
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What's New?

New Functionality

Biomechanics Single Action Analysis
This new tool measures biomechanical data on a worker in a given pose. 
It calculates and gives information such as the lumbar spinal loads and 
the forces and moments on manikin joints.

Enhanced Functionalities

Catalog management
Additional manikin attributes can now be saved within catalogs and there 
is greater flexibility in the use of catalogs. The icons for catalog 
management in the Tools have changed.

Manikin Tools toolbar
For ease of use, this toolbar has been added. Previously these commands 
were accessed through the Human Builder workbench.

Removed Functionalities

The Load Library and Save in Library commands are removed. All existing 
libraries must be converted to catalogs.
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Getting Started
This tutorial provides a "feel" of what Human Activity Analysis can do. It 
provides a step-by-step scenario showing you how to use key functions.

The tasks described in this section are:
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Accessing the Ergonomic Analysis 
Workbench

This procedure describes how to access the Ergonomic Analysis 
Workbench. 

If you do not have an active product with a manikin, follow these 
steps to access the Ergonomic Analysis Workbench. If you do have 
an active product with a manikin, jump to step 5.

1. In the File menu, select New. 

2. In the New dialog box, select Product, then click on OK. 
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3. In the Start menu, select Ergonomic Design & Analysis -> 
Human Builder. A manikin can now be created in order to perform 
an ergonomic analysis.

4. In the Insert menu, select Manikin. A manikin is created. You can 
now change its posture to suit the task you want to analyze. 

5. In the Start menu, select Human Activity Analysis. You are now 
ready to start an ergonomic analysis. 

Select the type of analysis you want to perform from the Ergonomic 
Tools toolbar.
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Analysis Introduction

This section gives some background information on the analysis of 
working postures in the workplace. It also describes the analyses types 
available in Human Activity Analysis. 

The Ergonomic Analysis toolbar includes four types of analyses:

●     RULA analysis

●     Lift/Lower analysis

●     Push/Pull analysis

●     Carry analysis

Some analyses require you to record two postures (initial and final 
posture) while others use the current posture of the manikin as a base 
for the analysis. 

As soon as the postures are set and recorded (if necessary) you can 
call each guideline individually and apply the analysis. The result of 
each analysis will appear at the bottom of the corresponding analysis 
window. Each dialog box allows you to specify the criterion required for 
that specific task such as duration and frequencies.

Note that all the analyses are real-time based. This means that if you 
modify the selected manikin's posture, the current analysis score will 
automatically be updated.

Note: You must select one manikin in the scene to be able to conduct 
the analysis. 

RULA analysis

The RULA (Rapid Upper Limb Assessment) system was developed at 
the University of Nottingham's Institute for Occupational Ergonomics 
(Reference: Lynn McAtamney and E. Nigel Corlett, RULA: A Survey 
Method for the Investigation of Work-related Upper Limb Disorders). It 
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was developed to investigate the exposure of individual workers to 
risks associated with work-related upper limb disorders. 

Lift/Lower analysis

In the Lift/Lower Analysis, you can choose between three guidelines: 
NIOSH 1981, NIOSH 1991, and Snook and Ciriello. These three 
guidelines require the use of an initial and a final posture in order to 
complete the analysis. A brief description of each guideline follows. 

NIOSH 1981

In 1981, NIOSH (National Institute for Occupational Safety and 
Health) published an algebraic equation for analyzing two-
handed symmetrical lifts. The lifting is based on a two-handed 
symmetrical lift with no upper body twisting, and the distance 
between hands is less than 75 cm (30 inches). This analysis 
requires a good coupling between the load and the hands as 
well as between the shoes and the floor surface. 

NIOSH 1991

The NIOSH 1991 equation also known as "the revised lifting 
equation" deals with two-handed manual lifting tasks. The 
equation handles a certain level of asymmetry. This analysis 
assumes an adequate coupling between the shoes and the floor 
surface. 

Snook and Ciriello

The Snook and Ciriello lifting and lowering analysis tool is 
based on a study done by S. Snook and V. Ciriello. As with the 
NIOSH equations, this analysis is based on two input postures. 
The lifting is based on a two-handed symmetrical lift. The 
action (lifting or lowering) is determined by the displacement of 
the load in the scene.

There are three levels of lifting and lowering with 
approximately 30 inches between each.
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●     from floor to knuckle height

●     from knuckle height to shoulder height

●     from shoulder height to arm reach

●     The horizontal distance is calculated from the chest to the 
mid-part of the hand grasp. 

Push/Pull analysis

The Snook and Ciriello pushing/pulling analysis tool is based on a 
study done by S. Snook and V. Ciriello at Liberty Mutual Insurance 
Company. This analysis allows you to compare actual data for a 
"pushing/pulling" task to what is considered as a safe force to perform 
that task.

There are 3 steps defined for the vertical height of hands for the 
pushing task:
●     from floor to 25 inches

●     from floor to 35 inches

●     from floor to 53 inches

There are six predefined distances for push:
●     7, 25, 50, 100, 150, and 200 foot push

The gender as well as the vertical height of hands are extracted from 
the selected manikin in the scene. 

Carry analysis

The Snook and Ciriello carrying analysis tool is based on a study done 
by S. Snook and V. Ciriello at Liberty Mutual Insurance Company. This 
analysis allows you to compare actual data for a carrying task to what 
is considered as a maximum acceptable weight of carry to perform 
that task.

This analysis considers two vertical height distances of hands for the 
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carrying task:

●     For males: from floor to 31 inches, from floor to 44 inches

●     For females: from floor to 28 inches, from floor to 41 inches

The manikin gender as well as the distance value for the hands are 
extracted from the selected manikin in the scene.
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User Tasks
These are the tasks that a user performs using Human Activity Analysis. 

RULA Analysis
Lift/Lower Analysis
Push/Pull Analysis

Carry Analysis
Biomechanics Single Action Analysis

How to Do a Safe Save in ENOVIA LCA from CATIA V5 
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RULA Analysis

This task describes the RULA analysis procedure using the RULA Analysis 
dialog box.

For more information on RULA analysis, see the Analysis Introduction in the 
Getting Started section.

Select the Launch RULA Analysis icon  from the Ergonomic Tools 

toolbar. The RULA Analysis dialog box appears. The fields to choose from are:

●     Manikin: Displays the name of the selected manikin.

●     Side: Select the side of the manikin that will be analyzed.

●     Parameters - Specify settings that are not automatically set.

●     Score - Displays the score obtained by the analysis.

Manikin:
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This is a read-only field that displays the name of the selected manikin.  

Side:

Use the two toggle buttons to select the side of the manikin that will be 
analyzed. 

Parameters

Use the options in this zone to specify settings that cannot be set 
automatically. 

Posture

Three types of postures are predetermined:
●     Static

●     Intermittent

●     Repeated

Select the one that best describes the worker's situation. 

Repeat Frequency

This parameter is used to determine the task frequency. Two choices 
are available:
●     Less than 4 times per minute

●     More than 4 times per minute

Shoulders are supported
Arms are working across midline
Check balance

Select one or more of these options to provide additional information 
that may affect the output of the RULA analysis. 

Load

Use this field to specify the weight of the manipulated object. Click 
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the arrows to increase or decrease the weight or use the keyboard to 
directly type a value into this field. 

Score

There are two modes for the score display: basic mode and advanced mode.

Basic mode

The data displayed in this mode is the final score accompanied by a 
colored zone. The color of this zone changes from green to red 
according to the final score.

The RULA analysis examines the following risk factors: number of 
movements, static muscle work, force, working posture, and time 
worked without a break. All these factors combine to provide a final 
score that ranges from 1 to 7.
●     1 and 2: (Green) Indicates that the posture is acceptable if it is not 

maintained or repeated for long periods of time.

●     3 and 4: (Yellow) Indicates that further investigation is needed and 
changes may be required.

●     5 and 6: (Orange) Indicates that investigation and changes are 
required soon.

●     7: (Red) Indicates that investigation and changes are required 
immediately.

●     Use the More>> button to switch from the basic mode to the 
advanced mode.
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Advanced mode

The data displayed in the basic mode is also displayed in the advanced mode. 
The advanced mode, in addition, also displays the intermediate scores. Some 
of these scores are obtained by subjective values. In the basic mode, these 
values are automatically set to default; in the advanced mode you can 
change these values. The score will then be modified to reflect these new 
values.
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Use the <<Less button to switch back to the basic mode.

Details section

The Details section that is displayed when you press the More>> button 
presents the score obtained for each section and used to calculate the final 
RULA score. The parameters of six of these segments can be edited:

Upper arm: Shoulder elevation
Arm abduction
Arm rotation

Forearm: Arm rotation

Wrist: Wrist deviation

Wrist twist: Wrist twist

Neck: Neck twist
Neck side-bending

Trunk: Trunk twist
Trunk side-bending

For each of the parameters, you have a choice of three options: Auto, Yes, 
and No.

Auto: (No or Yes): RULA is using the parameters defined in the 
RULA Parameters field (Tools->Options->Ergonomics 
Design & Analysis) to determine the state of a specific 
segment, i.e., Shoulder in elevation or not, Arm in abduction 
or not, etc.

Yes: By selecting Yes, you force RULA to consider that the 
segment is at the specified state (elevation, abduction, etc.) 
no matter what the posture of the selected manikin is.

No: By selecting No, you force RULA to consider that the 
segment is not at the specified state (elevation, abduction, 
etc.) no matter what the posture of the selected manikin is.

These intermediate scores, represented by a number and a color, are used to 
calculate the final RULA score. The following table indicates the score range 
for each segment as well as the associated color.
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Segment Score
Range

Color associated to the score

1 2 3 4 5 6

Upper arm 1 to 6       

Forearm 1 to 3       

Wrist 1 to 4       

Wrist twist 1 to 2       

Neck 1 to 6       

Trunk 1 to 6       

  

For more information on the RULA method, please read the following page 
that explains the steps for manually carrying the RULA evaluation. 

RULA Employee Assessment Worksheet

For more information about customization, please see Customizing RULA 
Specifications.
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Lift/Lower Analysis

This task describes the lift/lower analysis procedure using the 
Lift/Lower Analysis dialog box.

For more information on lift/lower analysis, see the Analysis 
Introduction in the Getting Started section.

Select the Lift/Lower Analysis icon   from the Ergonomic Tools 

toolbar. The Lift/Lower Analysis dialog box appears. The fields to 
choose from are:

●     Manikin: Displays the name of the selected manikin.

●     Posture - Set the initial and final postures.

●     Guideline - Choose the applicable guideline.

●     Specifications - Choose or enter criterion corresponding to your 
selected guideline:
❍     for NIOSH 1981

❍     for NIOSH 1991

❍     for Snook & Ciriello 

The Specifications zone will change as different guidelines are 
chosen. Read the section related to each guideline for detailed 
information regarding individual specifications.

●     Score - Displays the score obtained by the analysis.
❍     for NIOSH 1981

❍     for NIOSH 1991

❍     for Snook & Ciriello
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Manikin:

A read-only field displays the name of the selected manikin. Everything 
done during the analysis session will apply to this manikin. 

Posture

This area of the dialog box has two functions:
●     Display and choose postures (Initial and Final toggle buttons)

●     Record or modify the selected posture (Record/Modify push button)

Initial and Final

Use these two toggle buttons to select which posture you want 
to record or modify. When the postures are recorded, use these 
buttons to switch back and forth between the two postures. The 
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manikin in the scene displays the current posture selected. 

Record/Modify

Use this push button to record a posture. Use the Initial and 
Final buttons to select the posture to be recorded. If the 
manikin's current posture does not respect the lifting task 
definition, an error message will be displayed with the list of the 
missing or bad prerequisites. 

Guideline

From this list, select the guideline to perform the lift/lower analysis. 
The guidelines available are NOSH 1981, NIOSH 1991, and Snook & 
Ciriello.

The Specifications and Scores will change depending on which guideline 
is chosen.

 

Specifications (for NIOSH 1981)

1 lift every:

Use this specification to determine lift frequency. Click on the 
arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard.

Duration:

28Page Human Activity Analysis Version 5 Release 13



Use this field to enter the duration of the work in hours per day. 
The work is considered:
●     occasional if the value is one hour or less

●     continuous if the value is 8 hours 

Score (for NIOSH 1981)

Immediately after the frequency and duration fields are completed, the 
results are displayed in the Score zone.

Action Limit (AL):

This value represents the weight below which the task could be 
considered as reasonably safe. 

Maximum Permissable Limit (MPL):

This value represents a limit above which the lifting task is 
considered as hazardous and requires engineering controls. 

Specifications (for NIOSH 1991)

1 lift every:

Use this specification to determine lift frequency. Click on the 
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arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard.

Duration:

Use this field to enter the duration of the work in hours per day. 
The work is considered:
●     occasional if the value is one hour or less

●     continuous if the value is 8 hours 

Coupling condition:

Use this function to quantify the quality of the hand-to-object. 
The coupling quality is classified as Good, Fair, and Poor.
●     Good - a comfortable grip in which the hand can easily wrap 

around the object

●     Fair - a grip in which the hand can be flexed about 90 
degrees.

●     Poor - when the the object is hard to handle (irregular, bulky, 
sharp edges, etc.)

Object weight:

Use this field to enter the load weight. This value is used for the 
lifting index calculation. 

Score (for NIOSH 1991)

Immediately after the frequency and duration fields are completed, the 
results are displayed in the Score zone.
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Origin

This result is based on the initial posture of the manikin.
●     Recommended Weight Limit:

The RWL is the load weight that healthy workers can lift over 
a certain period of time without risk.

●     Lifting Index:
The LI provides a relative estimate of the level of physical 
stress.

Destination

This result is based on the final posture of the manikin.
●     Recommended Weight Limit:

The RWL is the load weight that healthy workers can lift 
without risk.

●     Lifting Index:
The LI provides a relative estimate of the level of physical 
stress.

Specifications (for Snook & Ciriello)

1 lift every:

Use this specification to determine lift frequency. Click on the 
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arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard.

Population sample:

Three population percentiles are provided: 90th, 75th, and 
50th. These percentiles represent the percentage of the 
population able to perform the task safely. The selected 
percentile takes the manikin gender into account.

Score (for Snook & Ciriello)

Immediately after the frequency and population sample fields are 
completed, the results are displayed in the Score zone.    

Maximum Acceptable Weight:

The maximum acceptable weight is defined as the weight that 
the selected population can handle with reasonable safety. 
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Push/Pull Analysis

This task describes how to execute a push/pull analysis using the 
Push/Pull Analysis dialog box. 

For more information on Push/Pull analysis, see the Analysis 
Introduction in the Getting Started section.

Select the Launch Push/Pull Analysis icon  from the Ergonomic 

Tools toolbar. The Push/Pull Analysis dialog box appears. The Push/Pull 
Analysis dialog box contains only the Snook & Ciriello guideline. This 
dialog box is divided into four parts:

●     Manikin: Displays the name of the selected manikin.

●     Guideline - Displays the current guideline.

●     Specifications - Choose or enter analysis criterion.

●     Score - Displays the score obtained by the analysis.
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Manikin:

A read-only field displays the name of the selected manikin. Everything 
done during the analysis session will apply to this manikin. 

Guideline

From this list, select the guideline to perform the Push/Pull analysis. In 
this analysis, only one guideline is available.

 

Specifications
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1 push every:

Use this field to determine the push frequency. Click on the 
arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard. 

Distance of push:

Use this field to specify the distance of the push. Click on the 
arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard. 

Distance of pull:

Use this field to specify the distance of the pull. Click on the 
arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard. 

Population sample:

Three population percentiles are provided: 90th, 75th, and 
50th. These percentiles represent the percentage of the 
population able to perform the task safely. The selected 
percentile takes the manikin gender into account. 

Score 

Immediately after the Specification fields are completed, the results are 
displayed in the Score zone.   
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The initial forces are required to initiate the object's motion. As the 
object begins to move, these forces will decline to a relatively constant 
level (sustained forces). 

Maximum acceptable initial force:

This value expresses the force required to put an object into 
motion. 

Maximum acceptable sustained force:

This value expresses the force required to keep the object in 
motion. 
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Carry Analysis

This task describes how to execute a carry analysis using the Carry 
Analysis dialog box. 

For more information on Carry analysis, see the Analysis Introduction 
in the Getting Started section.

Select the Launch Carry Analysis icon   from the Ergonomic Tools 

toolbar. The Carry Analysis dialog box appears. The Carry Analysis 
dialog box contains only the Snook & Ciriello guideline. This dialog box 
is divided into four parts:

●     Manikin: Displays the name of the selected manikin.

●     Guideline - Displays the current guideline.

●     Specifications - Choose or enter analysis criterion.

●     Score - Displays the score obtained by the analysis.

Manikin:

A read-only field displays the name of the selected manikin. Everything 
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done during the analysis session will apply to this manikin. 

Guideline

This list presents the guidelines available to perform Carry Analysis. 
Only one guideline is available.

 

Specifications

 

1 carry every:

Use this field to determine the carry frequency. Click on the 
arrows to increase or decrease the value indicated in the text 
field or directly enter a new value using the keyboard. 

Distance of carry:

This specification is used to determine the distance the object 
will be carried. Click the arrows to increase or decrease the 
value indicated in the text field or directly enter a new value 
using the keyboard. 

Population sample:

Three population percentiles are provided: 90th, 75th, and 
50th. These percentiles represent the percentage of the 
population able to perform the task safely. The selected 
percentile takes the manikin gender into account. 
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Score

Immediately after the Specification fields are completed, the results 
are displayed in the Score zone. 

 

Maximum Acceptable Weight:

The maximum acceptable weight is defined as the weight that 
the selected population can carry with reasonable safety. 
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Biomechanics Single Action Analysis

This procedure describes how to use the Biomechanics Single Action Analysis command. 

This ergonomic tool measures biomechanical data on a worker in a given pose. From the 
current manikin posture, the Single Action Analysis tool calculates and outputs information 
such as the lumbar spinal loads (abdominal force, abdominal pressure, body movements) 
and the forces and moments on manikin joints. All the output incorporated in the model are 
based on research results and algorithms published by the scientific community.

The forces (loads) acting on the manikin's hands are taken into account in the biomechanical 
analysis; these forces represent the load of carry, push, lift/lower, or pull, depending on the 
scenario, and are available for the hands only. Both the Load Properties and the 
Biomechanics Single Action Analysis dialog boxes can be open at the same time. The last 
analysis is updated when the load is modified.

1. In the Ergonomics Tools toolbar, select the Biomechanics: Single Action Analysis 
command. 

 2. In the PPR tree or the 3D view, select a manikin for the analysis.

The Biomechanics Single Action Analysis dialog box for that manikin appears, open to the 
default Summary tab.

Read more about the:
●     Summary tab

●     L4-L5 Spine Limit tab

●     Joint Moment Strength Data tab

●     Reaction Forces and Moments tab

●     Segment Positions tab

●     Export button

 These are the tabs and associated information in this dialog box:

Summary tab

The Summary tab gives general biomechanics information such as:
●     L4-L5 Moments

●     L4-L5 Compression

●     L4-L5 Joint Shear

●     Abdominal Force and Pressure

●     Ground Reaction
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L4-L5 Spine Limit tab

The L4-L5 Spine Limit tab displays the evaluation of the posture and whether it exceeds 
the compression and joint shear limits recommended by NIOSH and the University of 
Waterloo. The information on this tab can be viewed as a list or as a chart, as shown 
below.

Joint Moment Strength Data tab

The Joint Moment Strength Data tab displays the evaluation of the percentage of a worker 
population that doesn't have the strength to perform a task based on strength studies 
such as those by Askew, An, Morrey and Chao (1987) for the elbow, Koski and McGill 
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(1994) for the shoulder, and Troup and Chapman (1969) for the lumbar.

This information can be displayed as a chart or as a list, as shown below:
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Reaction Forces and Moments tab

The Reaction Forces and Moments displays, in detail, the reaction forces (N) and 
orthopedic moments (Nm) proximal and distal segments.

Segment Positions tab

The Segment Positions tab displays information (position, angle, center of gravity, length) 
about the segments.
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Export results

Use the Export button to save the biomechanical data in a text file. In the Export results 
dialog box, select the type of information you want to save and click on OK.

The biomechanical data is saved as a text file.
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How to Do a Safe Save into ENOVIA 
LCA from CATIA V5

The objective of Safe Save is to prevent the user from building / editing data in CATIA V5 if 
they cannot be saved in ENOVIA LCA. Therefore, in interoperability mode, some CATIA V5 
commands are grayed out / hidden in the Product Structure workbench.

Only commands subject to restrictions are listed below. And in some cases, 
rules are applied to restricted commands.

  
 

Workbench Feature Command

Accessibility 
in LCA mode Warning / 

Comment

Save 
in 

LCA / 
Rules

 
 
 
H
U
M
A
N
 
A
C
T
I
V
I
T
Y
 

Manikin 
Simulation

Shuttle NO (grayed 
out)

  

Simulation NO (grayed 
out)

  

Generate 
Replay

NO (grayed 
out)

  

Generate 
Video

NO (grayed 
out)

  

Replay NO (grayed 
out)

  

Track NO (grayed 
out)

  

Play a 
Simulation

NO (grayed 
out)

  

45Page Human Activity Analysis Version 5 Release 13



A
N
A
L
Y
S
I
S
 
 
 

Manikin 
Workspace 
Analysis

Distance 
and Band 
Analysis

YES The result 
of this 
command 
cannot be 
saved.

NO

Arc Through 
Three 
Points

YES The result 
of this 
command 
cannot be 
saved.

NO

Measure 
Between

YES The result 
of this 
command 
cannot be 
saved.

NO
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Workbench Description
The Human Activity Analysis Version 5 application window looks like this.

Click the hotspots to see the related documentation.
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Human Activity Analysis Menu Bar

Start File Edit View Insert Tools Window Help

  

Start

For

Human Activity Analysis 

See

Accessing the 
Ergonomic 
Analysis 
Workbench

File

For

New...

See

Accessing the 
Ergonomic 
Analysis 
Workbench

Tools

For See

Posture Editor Using the 
Posture Editor
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Standard Pose Applying 
Standard Poses

Analyze

For See

RULA Analysis RULA Analysis 

Lift-Lower Analysis Lift/Lower 
Analysis 

Push-Pull Analysis Push/Pull 
Analysis 

Carry Analysis Carry Analysis 
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Ergonomic Tools Toolbar

See  RULA Analysis 

See  Lift/Lower Analysis 

See  Push/Pull Analysis 

See  Carry Analysis 

See Biomechanics: Single Action Analysis
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Manikin Posture Toolbar

See Using the Posture Editor in the Human Builder User Guide.

See Using Forward Kinematics in the Human Builder User Guide.

See Using the Inverse Kinematics Segment Frame Mode and Worker 
Frame Mode in the Human Builder User Guide.

See Redefining the Segment Offset for Inverse Kinematics in the 
Human Builder User Guide.

See Redefining the Segment Offset for Inverse Kinematics in the 
Human Builder User Guide

See Inverse Kinematics Behaviors in the Human Builder User Guide.

See Interactive Positioning with the Reach Command in the Human 
Builder User Guide.

See Interactive Positioning with the Reach Command in the Human 
Builder User Guide.

See Using the Place Mode in the Human Builder User Guide.

See Applying Standard Poses in the Human Builder User Guide.      

See Managing Multiple Constraints in the Human Builder User Guide.
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Manikin Tools Toolbar

See Changing Manikin Display Attributes in the Human Builder User 
Guide.

See Inverse Kinematics Behaviors in the Human Builder User Guide.

See Assigning Descriptions (Memos) in the Human Builder User Guide.

See Using the Vision Function in the Human Builder User Guide.

See Using the Reach Envelope in the Human Builder User Guide.

See Attaching an Object to a Manikin Segment in the Human Builder 
User Guide.

See Manikin Catalog Management in the Human Builder User Guide.

See Manikin Catalog Management in the Human Builder User Guide.
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Manikin Simulation Toolbar
This toolbar contains the following tools:

See Using the Shuttle Command in the Human Builder User Guide.

See Using the Simulation Command in the Human Builder User Guide.

See Using the Compile Simulation Command in the Human Builder User 
Guide.

See Using the Replay Command in the Human Builder User Guide.

See Using the Track Command in the Human Builder User Guide.

See Using the Play Simulation Command in the Human Builder User 
Guide.

See Using Global Collision Detection in the Human Builder User Guide.

See Using Global Collision Detection in the Human Builder User Guide.

See Using Global Collision Detection in the Human Builder User Guide.
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Manikin Workspace Analysis

See Distance and Band Analysis in the Human Builder User Guide.

See Arc Through 3 Points Analysis in the Human Builder User Guide.

See Measure Between Analysis in the Human Builder User Guide.
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Customizing RULA Specifications

This task describes how to customize the specifications for the RULA (Rapid Upper Limb 
Assessment) Analysis. 

You can customize a total of nine parameters, thus influencing the result of the RULA 
analysis. These parameters define the threshold values for different degrees of freedom:

1.  Shoulder elevation threshold
2.  Upper arm abduction threshold
3.  Arm rotation threshold
4.  Wrist deviation threshold
5.  Wrist twist threshold
6.  Neck twist threshold
7.  Neck side-bending threshold
8.  Trunk twist threshold
9.  Trunk side-bending threshold

To customize the RULA parameters, select Tools -> Options from the main menu. Go to 
the Ergonomics Design & Analysis section and select Human Activity Analysis. 

The Ergonomic Analysis tab displays the default values of the different RULA parameters.
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These nine parameters are used to transform the questions involved in the RULA process to 
angle comparisons. For example, during the calculation of the RULA result the question 
might be, Is the neck bending to the side? The question is subjective unless a threshold is 
set. For this particular case, the software compares the value of DOF 2 of the subject 
manikin's neck with the threshold defined in the RULA settings. If the value of that DOF is 
greater than 18.375 degrees, then RULA considers the neck to be bending.

If the user determines that 18.375 degrees (default threshold) is not an appropriate value 
for the neck, this value may be overridden. The new value entered by the user will then be 
used for the next RULA calculation, and the output will be affected accordingly.
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Glossary

E
ergonomics An applied science concerned with designing and arranging 

things people use so that the people and things interact 
most efficiently and safely.

M
maximum 
acceptable 
initial force

The force required to put an object in motion.

maximum 
acceptable 
sustained 
force

The force required to keep an object in motion.

maximum 
acceptable 
weight

The weight that the selected population can carry with 
reasonable safety.

N
NIOSH National Institute for Occupational Safety and Health

R
RULA Rapid Upper Limb Assessment

RULA 
analysis

Developed to investigate the exposure of individual workers 
to risks associated with work-related upper limb disorders.
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Index 
            

A
analysis, 

carry   

lift/lower   

push/pull   

RULA   

B
Biomechanics Single Action Analysis command  

C
carry analysis   

commands  

Arc through 3 Points Analysis  

Biomechanics Single Action Analysis  

Carry Analysis  

Compile Simulation  

Distance and Band Analysis  

Forward Kinematics  

Global Collision (Off)  

Global Collision (On)  

Global Collision (Stop)  

Inverse Kinematics Segment Frame  
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Inverse Kinematics Worker Frame  

Lift/Lower Analysis  

Measure Between Analysis  

Place  

Play Simulation  

Posture Editor  

Push/Pull Analysis  

Replay  

RULA Analysis  

Shuttle  

Standard Pose  

Track  

Update  

E
Ergonomic Analysis workbench, accessing  

Ergonomic Tools toolbar  

L
lift/lower analysis   

M
Manikin Posture toolbar  

Manikin Simulation toolbar  
menu bar, 

File  
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Start  

N
NIOSH 1981  
NIOSH 1981, 

score for  

specifications for  

NIOSH 1991  
NIOSH 1991, 

score for  

specifications for  

P
push/pull analysis   

R
RULA analysis   

RULA specifications, customizing  

S
Simulation 

commands  
Snook & Ciriello, 

score for  

specifications for  
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Snook and Ciriello  

T
toolbar 

Ergonomic Tools  

Manikin Posture  
toolbars 

Manikin Simulation toolbar  

Manikin Tools  

Manikin Workspace Analysis  

W
workbench description  
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